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BAB III 

METODE PENELITIAN 

 

3.1 Desain Penelitian 

Penelitian ini menggunakan paradigma kuantitatif dengan pendekatan 

interdisiplin menggunakan metode penelitian eksperimen. Metode eksperimen 

merupakan metode penelitian yang terbaik untuk mengungkap keterkaitan sebab 

akibat antar variabel seperti yang dinyatakan oleh Fraenkel dkk. (2012, hlm.265) 

“Of the many types of research that might be used, the experiment is the best way 

to establish cause-and-effect relationships among variables”. Lebih lanjut lagi 

Darmadi (2011, hlm. 175) menyatakan “Penelitian eksperimen adulah satu-

satunya metoda penelitian yang benar-benar dapat menguji hipotesis hubungan 

sebab-akibat”.Dalam penelitian eksperimen terdapat karakteristik yang paling 

utama adalah adanya variabel bebas yang dimanipulasi seperti yang dinyatakan 

olehFraenkel dkk. (2012, hlm.265)“The major characteristic of experimental 

research that distinguishes it from all other types of research is that researchers 

manipulate the independent variable”. Arti dari pernyataan tersebut mengatakan 

bahwa karakteristik utama dari penelitian eksperimental yang membedakannya 

dari semua jenis penelitian lainnya adalah bahwa peneliti memanipulasi variabel 

independen. Jadi dari pernyataan tersebut, maka variabel bebas yang dimanipulasi 

dalam penelitian ini adalahProject Based Learing. Dalam penelitian ini metode 

eksperimen yang digunakan adalah pre-eksperimental designs. Sugiyono (2016, 

hlm. 109) menyatakanpre-eksperimental designs sebagai berikut: 

 

Dikatakan pre-experimental design, karena desain ini belum merupakan 

eksperimen sungguh-sungguh. Mengapa?, karena masih terdapat variabel 

luar yang ikut berpengaruh terhadap terbentuknya variabel dependen. Jadi 

hasil eksperimen yang merupakan variabel dependen itu bukan semata-

mata dipengaruhi oleh variabel independen.  

 

Desain penelitian yang digunakan dalam penelitian ini adalahOne-Group 

Pretest-Posttest Design. Sugiyono (2016, hlm. 110) menjelaskan desain One-

29 
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Group Pretest-Posttest Design “... pada desain ini terdapat pretest, sebelum diberi 

perlakuan. Dengan demikian hasil perlakuan dapat diketahui lebih akurat, karena 

dapat membandingkan dengan keadaan sebelum diberi perlakuan”. Desain 

penelitian eksperimen model ini dapat digambarkan seperti berikut. 

O1          X          O2 

 

Gambar 3.1. 

One-Group Pretest-Posttest Design 

Keterangan:  

X 

O1 

O2 

= 

= 

= 

treatment yang diberikan (Project Based Learing) 

nilai pretest (sebelumtreatment Project Based Learing) 

nilai posttest (sesudah treatment Project Based Learing) 

Berdasarkan dari pemaparan di atas, peneliti bermaksud untuk 

memberikan treatment terhadap suatu kelompokdengan menggunakan Project 

Based Learning yang sebelumnya diberikan pretestmotivasi kewirausahaan 

terlebih dahulu, yang kemudian hasil dari treatment tersebut dilihat hasil posttest 

terhadapmotivasi kewirausahaan.  

 

3.2 Partisipan  

Partisipan dalam penelitian ini adalah siswa kelas XI SMK NU Kaplongan 

Indramayu konsentrasi Administrasi Perkantoran (APK) tahun ajaran 2017-2018 

semester dua sebanyak 111 siswa. Waktu Penelitian kurang lebih selama tiga 

bulan mulai bulan April 2018 sampai bulan Mei 2018 dengan frekuensi 

pertemuan sebanyak 9 kali pertemuan. Penelitian ini dilakukan di SMK NU 

Kaplongan Indramayu yang beralamat di Jl. Raya Kaplongan No. 28 

Karangampel Indramayu. 

 

3.3 Populasi dan Sampel 

3.3.1 Populasi 
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Populasi merupakan kelompok penelitian yang akan digeneralisasikan 

hasilnya untuk mendapatkan kesimpulan penelitian seperti yang dinyatakan oleh 

Sugiyono (2016, hlm. 117) “Populasi adalah wilayah generalisasi yang terdiri 

atas: obyek/subyek yang mempunyai kualitas dan karakteristik tertentu yang 

ditetapkan oleh peneliti untuk dipelajari dan kemudian ditarik kesimpulannya”. 

Dari pernyataan tersebut dan berdasarkan partisipan yang telah dipaparkan, maka 

populasi dalam penelitian ini adalah siswa kelas XI SMK NU 

KaplonganIndramayu konsentrasi Administrasi Perkantoran (APK) sebanyak 111 

siswa. 

3.3.2 Sampel  

Sampel adalah jumlah kecil dari populasiyangmemiliki keadaan tertentu 

yang akan diperoleh informasi dari penelitian seperti yang dinyatakan Riduwan 

(2011, hlm. 56) menyatakan “Sampel adalah bagian dari populasi yang 

mempunyai ciri-ciri atau keadaan tertentu yang akan diteliti”. Lebih lanjut lagi 

Sugiyono (2016, hlm. 118) menyatakan “Sampel adalah bagian dari jumlah dan 

karakteristik yang dimiliki oleh populasi tersebut”. Berdasarkan kebutuhan 

penelitian, maka peneliti menggunakan teknik samplingsitematis dalam 

pengambilan sampel di dalam penelitian ini dengan menggunakan kelipatan dari 

bilangan 3 (3,6,9,12,15, dan seterusnya sampai 111), sehingga didapat jumlah 

sampel sebanyak 37 orang. Sugiyono (2016, hlm. 123) menyatakan pengambilan 

sampel menggunakan teknik samplingsistematis sebagai berikut. 

 

Sampling Sistematis adalah teknik pengambilan sampel berdasarkan 

urutan dari anggota populasi yang telah diberi nomor urut. Misalnya 

anggota populasi yang terdiri dari 100 orang. Dari semua anggota itu 

diberi nomor urut, yaitu nomor 1 sampai dengan nomor 100. Pengambilan 

sampel dapat dilakukan dengan nomor ganjil saja, genap saja, atau 

kelipatan dari bilangan tertentu. 

 

3.3.3 Lokasi Penelitian 

Lokasi penelitian berlokasi di SMK NU Kaplongan Indramayu yang 

terletak di Jalan Raya Kaplongan no. 28. SMK NU Kaplongan didirikan pada 
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tahun 2002 dilahan seluas 25 hektar. Sekolah ini memiliki 5 program keahlian 

yakni Teknik Kendaraan Ringan, Teknik Sepeda Motor, Teknik Komputer 

Jaringan, Administrasi Perkantoran, dan yang terakhir Multimedia. Akreditasi 

SMK NU Kaplongan yaitu A dengan kepala sekolah SMK NU Kpalongan yaitu 

Bapak Tobroni, M.Pd, M. Si. 

 

3.4 Instrumen Penelitian 

Instrumen penelitian merupakan alat atau fasilitas yang digunakan oleh 

peneliti dalam mengumpulkan data. Instrumen penelitian sangat berpengaruh 

terhadap keberhasilan suatu penelitian, oleh karena itu penyusunan instrumen 

penelitian harus dirancang dengan baik agar diperoleh hasil sesuai dengan 

kegunaannya.  Dalam penelitian ini instrumen yang digunakan untuk mengetahui 

motivasi kewirausahaandengan menggunakan angket, sedangkan untuk 

mengetahui implementasi Project Based Learning dengan menggunakan 

observasi. Berikut merupakan gambaran variabel dalam penelitian ini: 

Variabel:   

X →                   Y 

(Project Based Learning) Moderator 

( Pergelaran seni) 

(Motivasi Kewirausahaan 

Seni) 

Gambar 3.2. 

Gambaran Variabel  

Tabel 3.1. 

Variabel Operasional 

No Variabel Aspek Indikator 

1. Project Based 

Learning 

• Tujuan • Motivasi kewirausahaan seni 

• Bahan • Gerak tari 

• Musik 

• Kostum 

• Make up dan property 
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• Metode • Project Based Learning 

• Evaluasi • Proyek pergelaran seni 

 

• PBM • Menetapkan konten dan tujuan 

keterampilan 

• Mengembangkan format untuk 

produk akhir 

• Merencanakan lingkup proyek 

• Rancangan kegiatan instruksional 

• Menilai desain proyek 

2. Pergelaran 

Seni 

• Tari • Tari Saman 

• Tari Piring 

• Tari Jaipong 

• Musik • CD/kaset 

• Property • Ikat kepala tari saman 

• Hiasan kepala tari piring 

• Hiasan kepala tari jaipong 

• Rias • Rias panggung 

3. Motivasi 

Kewirausahaan 

• Alasan 

keuangan 

• Mencari nafkah 

• Menjadi kaya 

• Mencari pendapatan tambahan 

• Stabilitas keuangan 

• Alasan sosial • Memperoleh status 

• Terkenal dan dihormati 

• Alasan 

pelayanan 

• Membuka lapangan pekerjaan 

• Menatar masyarakat 

• Membantu ekonomi masyarakat 

• Masa depan, kesetiaan, dan 

kebahagiaan keluarga 
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• Alasan 

pemenuhan diri 

• Menjadi mandiri 

• Menjadi lebih produktif 

• Menggunakan kemampuan pribadi 

 

3.4.1 Angket 

Di dalam angket ini menggunakan skala likert.  Riduwan (2011, hlm. 87) 

menyatakan “Skala Likert digunakan untuk mengukur sikap, pendapat persepsi 

seorang atau kelompok tentang kejadian atau gejala sosial”. Dari pendapat 

tersebut berkaitan dengan penelitian ini angket yang digunakan dalam penelitian 

ini ditujukan untuk mengukur motivasi kewirausahaan. Berikut kisi-kisi alat 

pengumpulan data motivasi kewirausahaan menurut Wirasasmita (1994, hlm. 8) 

sebagai berikut. 

Tabel 3.2. 

Kisi- Kisi Alat Pengumpulan Data Motivasi Kewirausahaan 

Aspek Sub Aspek 
No. Pertanyaan 

Jumlah 
Positif Negatif 

Alasan 

Keuangan 

Mencari nafkah 

Menjadi kaya 

Mencari pendapatan tambahan 

Stabilitas keuangan 

1,2 

5,6 

9,10 

13,14 

3,4 

7,8 

11,12 

15,16 

4 

4 

4 

4 

Alasan 

Sosial 

Memperoleh status 

Terkenal dan dihormati 

17,18 

21,22 

19,20 

23,24 

4 

4 

Alasan 

pelayanan 

Membuka lapangan pekerjaan 

Menatar masyarakat 

Membantu ekonomi masyarakat 

Masa depan, kesetian, dan 

kebahagian keluarga 

25,26 

29,30 

33,34 

 

37,38 

27,28 

31,32 

35,36 

 

39,40 

4 

4 

4 

 

4 

Alasan 

pemenuhan 

diri 

Menjadi mandiri 

Menjadi lebih produktif 

Menggunakan kemampuan 

pribadi 

41,42 

45,46 

49,50 

 

43,44 

47,48 

51,52 

4 

4 

4 

Jumlah 52 

 

Untuk mempermudah proses penelitian maka peneliti merumuskan sub 

aspek yang telah disusun ke dalam bentuk pertanyaan/ pernyataan tetapi sebelum 

menyusun, untuk lebih meyakinkan kueisioner yang akan digunakan peneliti 
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melakukan terlebih dahulu melakukan uji validasi isi skala motivasi 

kewirausahaan kepada expert judgment sebanyak satu orang dosen yang ahli di 

bidang kewirausahaan untuk lembar validasi isi ahli dapat dilihat pada lampiran 1. 

Kemudian hasil dari validasi isi oleh expert judgment tersebut dilakukan uji coba 

skala kecil mengenai ketercabaan bahasa dan kalimat kepada 20 orang siswa SMK 

NU Kaplongan untuk lembar uji coba skala kecil dapat dilihat pada lampiran 2. 

Adapun untuk hasil uji coba skala kecil tersebut dapat dilihat pada lampiran 3. 

Berikut prosentase hasil jawaban uji coba skala kecil yang telah dilakukan dan 

untuk hasil uji coba skala kecil: 

Tabel 3.3. 

Hasil Uji Coba Skala Kecil 

Nomor 

Pertanyaan/ 

Pernyataan 

Alternatif Jawaban Prosentase 

Jawaban 

Mengerti 
Mengerti Tidak Mengerti Jumlah 

1 19 1 20 95% 

2 20 0 20 100% 

3 15 5 20 75% 

4 19 1 20 95% 

5 18 2 20 90% 

6 18 2 20 90% 

7 15 5 20 75% 

8 16 4 20 80% 

9 18 2 20 90% 

10 19 1 20 95% 

11 18 2 20 80% 

12 17 3 20 85% 

13 16 4 20 80% 

14 16 4 20 80% 

15 16 4 20 80% 

16 15 5 20 75% 

17 20 0 20 100% 

18 19 1 20 95% 

19 18 2 20 90% 

20 16 4 20 80% 

21 16 4 20 80% 

22 18 2 20 90% 

23 18 2 20 90% 

24 17 5 20 85% 

25 20 0 20 100% 
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26 18 2 20 90% 

27 15 5 20 75% 

28 19 1 20 95% 

29 19 1 20 95% 

30 17 3 20 85% 

31 15 5 20 75% 

32 18 2 20 90% 

33 19 1 20 95% 

34 17 3 20 85% 

35 16 4 20 80% 

36 17 3 20 85% 

37 20 0 20 100% 

38 16 4 20 80% 

39 15 5 20 75% 

40 16 4 20 80% 

41 19 1 20 95% 

42 18 2 20 90% 

43 17 3 20 85% 

44 18 2 20 90% 

45 19 1 20 95% 

46 19 1 20 95% 

47 18 2 20 90% 

48 19 1 20 95% 

49 19 1 20 95% 

50 18 2 20 90% 

51 17 3 20 85% 

52 17 3 20 85% 

 

Berdasarkan tabel di atas dapat dilihat bahwa dari uji coba skala kecil yang 

dilakukan terhadap 20 orang siswa, setiap butir soal pertanyaan/ pernyataan 

mencapai kisaran 75% sampai dengan 100% siswa yang mengerti dengan kalimat 

pertanyaan/ pernyataan yang diajukan. Oleh karena itu, semua butir soal dapat 

digunakan kelangkah selanjutnya dalam uji coba instrumen skala besar untuk 

mencari uji validitas dan reliabilitas butir soal yang nantinya akan digunakan 

sebagai instrumen penelitian sebelum melakukan uji coba skala besar peneliti 

menyusun terlebih dahulu ke dalam lembar jawaban uji coba instrumen skala 

besar dalam bentuk pertanyaan/ pernyataan yang dapat dilihat pada lampiran 4. 

3.4.1.1 Uji Validitas Instrumen Motivasi Kewirausahaan 
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Perhitungan validitas intrumen motivasi kewirausahaan dihitung dengan 

menggunakan bantuan SPSS dengan langkah-langkah menurut Sarwono (2006, 

hlm. 227) sebagai berikut: klik Analyze>Scale >Reliability Analysis... > Masukan 

semua variabel ke kotak Items >pada bagian Model: pilih Alpha 

>Continue>OK.Berdasarkan kepada hasil perhitungan dengan membandingkan 

nilai rhitung dengan nilai rtabel. Jika  rhitung> rtabel maka item  butir tes dinyatakan 

valid, berdasarkan hasil kepada rtabel dengan jumlah sampel sebanyak 72 maka 

didapat nilai rtabel sebesar 0,232. Berikut rekapitulasi hasil perhitungan uji validitas 

butir soal yang telah disebar kepada 72 orang siswa dan untuk hasil perhitungan 

SPSS dapat dilihat pada lampiran 6. 

Tabel 3.4. 

Hasil Uji Validitas Butir Soal 

Nomor 

Pertanyaan/ 

Pernyataan 

rhitung rtabel Keterangan 

1 0,459 0,232 Valid  

2 0,603 0,232 Valid 

3 0,418 0,232 Valid 

4 0,416 0,232 Valid 

5 0,119 0,232 Tidak Valid 

6 0,494 0,232 Valid 

7 0,410 0,232 Valid 

8 0,382 0,232 Valid 

9 0,430 0,232 Valid 

10 0,522 0,232 Valid 

11 0,205 0,232 Tidak Valid 

12 0,454 0,232 Valid 

13 0,556 0,232 Valid 

14 0,616 0,232 Valid 

15 0,642 0,232 Valid 

16 0,508 0,232 Valid 

17 0,468 0,232 Valid 

18 0,392 0,232 Valid 

19 0,488 0,232 Valid 

20 0,518 0,232 Valid 

21 0,258 0,232 Valid 



38 

 

Reni Anggraeni, 2018 
IMPLEMENTASI PROJECT BASED LEARNING DALAM MEWUJUDKAN PERGELARAN UNTUK 
MEMOTIVASI KEWIRAUSAHAAN SENI SISWA SMK  
Universitas Pendidikan Indonesia | repository.upi.edu | perpustakaan.upi.edu 

 

22 0,129 0,232 Tidak Valid 

23 0,396 0,232 Valid 

24 0,399 0,232 Valid 

25 0,340 0,232 Valid 

26 0,603 0,232 Valid 

27 0,422 0,232 Valid 

28 0,554 0,232 Valid 

29 0,577 0,232 Valid 

30 0,654 0,232 Valid 

31 0,462 0,232 Valid 

32 0,494 0,232 Valid 

33 0,385 0,232 Valid 

34 0,479 0,232 Valid 

35 0,601 0,232 Valid 

36 0,119 0,232 Tidak Valid 

37 0,379 0,232 Valid 

38 0,185 0,232 Tidak Valid 

39 0,197 0,232 Tidak Valid 

40 0,310 0,232 Valid 

41 0,682 0,232 Valid 

42 0,129 0,232 Tidak Valid 

43 0,654 0,232 Valid 

44 0,194 0,232 Tidak Valid 

45 0,416 0,232 Valid 

46 0,682 0,232 Valid 

47 0,494 0,232 Valid 

48 0,410 0,232 Valid 

49 0,382 0,232 Valid 

50 0,430 0,232 Valid 

51 0,601 0,232 Valid 

52 0,205 0,232 Tidak Valid 

 

Dari tabel di atas dapat dilihat bahwa dari 52 butir soal yang telah di 

hitung validitasnya terdapat 9 butir item yang tidak valid yaitu nomor 5, 11, 22, 

36, 38, 39, 42, 44,dan 52 sehingga 9 butir soal tersebut dihilangkan atau dibuang 

sedang sisanya sebanyak 43 dapat digunakan sebagai instrumen penelitian yang 

terlebih dahulu dihitung nilai reliabilitasnya. 
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3.4.1.2 Uji Reliabilitas Instrumen Motivasi Kewirausahaan 

Berdasarkan kepada uji validitas yang telah dilakukan didapat sebanyak 43 

butir soal yang valid, sehingga perlu dilakukan uji reliabilitas untuk mengetahui 

keteradanan alat ukur tersebut. Perhitungan reliabilitas intrumen motivasi dengan 

menggunakan bantuan SPSS dengan langkah-langkah menurut Sarwono (2006, 

hlm. 224) sebagai berikut: klik Analyze>Scale >Reliability Analysis... > Masukan 

semua variabel ke kotak Items >pada bagian Model: pilih Alpha 

>Continue>OK.Untuk hasil perhitungan yang didapat hasil reliabilitas instrumen 

dengan melihat Cronbach's Alpha. Berikut rekapitulasi hasil perhitungan uji 

reliabilitas yang telah dilakukan dan untuk hasil perhitungan SPSS dapat dilihat 

pada lampiran 7. 

Tabel 3.5. 

Hasil Uji Reliabilitas Instrumen 

Varibel  Cronbach's Alpha 

Motvasi Kewirausahaan 0,937 

 

Dari hasil validitas dan reliabilitas instrumen yang telah dilakukan berikut 

bentuk angket yang digunakan di dalam penelitian ini: 

Tabel  3.6. 

Instrumen Penelitian Angket 

 

Angket Motivasi Kewirausahaan 

 

Dengan segala kerendahan hati, dalam rangka pengisisan angket anda 

dimohon bantuannya untuk mengisi angket motivasi kewirausahaan. Jawaban 

yang anda berikan dijamin akan kerahasiannya dan tidak akan mempengaruhi 

nilai anda dalam mata pelajaran seni budaya, karena angket ini ditujukan untuk 

kepentingan penelitian dalam rangka penyusunan tesis yang berjudul 

“Implementasi Model Project Based Learning Dalam Mewujudkan Pergelaran 

Untuk Memotivasi Kewirausahaan Seni Siswa SMK”. 

Atas segala perhatian dan bantuannya saya ucapkan terima kasih, 
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semoga segala bantuannya mendapat balasan yang lebih baik dan berlipat ganda 

dari Allah SWT. Amiin. 

Contoh pengisian angket: 

Berilah tanda check list (X) pada salah satu alternatif jawaban yang tersedia 

dengan pilihan dan pengamatan anda. 

 

 

Keterangan alternatif jawaban : 

SS : Sangat Setuju 

S : Setuju 

KS : Kurang Setuju 

TS : Tidak Setuju 

STS  : Sangat Tidak Setuju 

Contoh Pernyataan: 

1. Saya sangat menyenangi sekali mengikuti pembelajaran seni budaya 

 SS  S  KS  TS  STS  

           

 

1. Saya merasa pagelaran seni yang saya ikuti akan menjadi ilmu untuk bekal 

pengalaman membuka usaha di bidang kesenian. 

 SS  S  KS  TS  STS  

 

2. Saya merasa pagelaran seni yang saya ikuti akan menjadi ilmu untuk 

membuka usaha sebagai penyelenggara pertunjukan seni. 

 SS  S  KS  TS  STS  

 

3. Saya merasa pagelaran seni yang saya ikuti untuk mendapatkan nilai mata 

pelajaran seni saja. 

 SS  S  KS  TS  STS  
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4. Saya merasa pagelaran seni yang saya ikuti hanya untuk ikut berpartisipasi 

saja dalam kegiatan tersebut. 

 SS  S  KS  TS  STS  

 

5. Saya merasa pagelaran seni yang saya ikuti akan menjadi ilmu untuk dapat 

penghasilan yang lebih menguntungkan. 

 SS  S  KS  TS  STS  

 

6. Saya merasa pagelaran seni yang saya ikuti sulit menghasilkan pendapatan 

yang lebih besar. 

 SS  S  KS  TS  STS  

 

7. Saya merasa pagelaran seni yang saya ikuti susah meningkatkan kualitas 

hidup yang lebih baik. 

 SS  S  KS  TS  STS  

 

8. Saya merasa pagelaran seni yang saya ikuti akan menjadi ilmu untuk 

mendapatkan penghasil tambahan. 

 SS  S  KS  TS  STS  

 

9. Saya merasa pagelaran seni yang saya ikuti akan menjadi ilmu untuk 

membantu keuangan. 

 SS  S  KS  TS  STS  

 

10. Saya merasa pagelaran seni yang saya ikuti sulit dalam mendapatkan 

keuntungan untuk memenuhi kebutuhan hidup. 

 SS  S  KS  TS  STS  

 

11. Saya merasa pagelaran seni yang saya ikuti akan menstabilkan keadaan 

keuangan. 
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 SS  S  KS  TS  STS  

 

12. Saya merasa pagelaran seni yang saya ikuti akan memberikan pemenuhan 

kebutuhan hidup. 

 SS  S  KS  TS  STS  

 

13. Saya merasa pagelaran seni yang saya ikuti hanya menambah biaya 

pengeluaran hidup saya. 

 SS  S  KS  TS  STS  

 

14. Saya merasa pagelaran seni yang saya ikuti banyak menimbulkan kerugian 

pada keuangan saya. 

 SS  S  KS  TS  STS  

 

15. Saya merasa pagelaran seni yang saya ikuti akan memberikan ide kepada 

saya menjadi seorang seniman. 

 SS  S  KS  TS  STS  

 

16. Saya merasa pagelaran seni yang saya ikuti akan memberikan ide kepada 

saya untuk menjadi penyelenggara kegiatan kesenian. 

 SS  S  KS  TS  STS  

 

17. Saya merasa pagelaran seni yang saya ikuti belum pasti memberikan 

kontribusi pada pekerjaan saya kelak. 

 SS  S  KS  TS  STS  

 

18. Saya merasa pagelaran seni yang saya ikuti kurang memberikan ilmu yang 

bermanfaat untuk hidup saya kelak. 

 SS  S  KS  TS  STS  
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19. Saya merasa pagelaran seni yang saya ikuti akan membuat saya terkenal 

sebagai seorang seniman. 

 SS  S  KS  TS  STS  

 

20. Saya merasa pagelaran seni yang saya ikuti belum pasti meningkatkan 

harga diri saya. 

 SS  S  KS  TS  STS  

 

21. Saya merasa pagelaran seni yang saya ikuti kurang mempengaruhi 

kepedulian dari orang lain terhadap saya. 

 SS  S  KS  TS  STS  

 

22. Saya merasa pagelaran seni yang saya ikuti akan memberikan saya peluang 

usaha yang baru. 

 SS  S  KS  TS  STS  

 

23. Saya merasa pagelaran seni yang saya ikuti akan memberikan saya 

lapangan pekerjaan sendiri. 

 SS  S  KS  TS  STS  

 

24. Saya merasa pagelaran seni yang saya ikuti belum pasti menciptakan 

lapangan pekerjaan yang layak. 

 SS  S  KS  TS  STS  

 

25. Saya merasa pagelaran seni yang saya ikuti akan sulit dalam mengemban 

usaha. 

 SS  S  KS  TS  STS  

 

26. Saya merasa pagelaran seni yang saya ikuti akan memberikan wawasan 

pertunjukan kesenian kepada masyarakat. 
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 SS  S  KS  TS  STS  

 

27. Saya merasa pagelaran seni yang saya ikuti akan memberikan pengaruh 

kepada masyarakat akan pentingnya kebudayaan. 

 SS  S  KS  TS  STS  

 

28. Saya merasa pagelaran seni yang saya ikuti sulit dalam pengembangan 

masyarkat. 

 SS  S  KS  TS  STS  

 

29. Saya merasa pagelaran seni yang saya ikuti kurang berpengaruh terhadap 

upaya pelestarian budaya dalam masyarakat. 

 SS  S  KS  TS  STS  

 

30. Saya merasa pagelaran seni yang saya ikuti akan membantu perekonomian 

masyarakat dengan menjadi penyelenggara kegiatan kesenian. 

 SS  S  KS   TS  STS  

 

31. Saya merasa pagelaran seni yang saya ikuti akan membantu membuka 

peluang kerja kepada masyarakat dengan menjadi penyelenggara kegiatan 

kesenian. 

 SS  S  KS  TS  STS  

 

32. Saya merasa pagelaran seni yang saya ikuti sulit menambah pendapatan  

tambahan dikalangan masyarakat. 

 SS  S  KS  TS  STS  

 

33. Saya merasa pagelaran seni yang saya ikuti akan menjadi masa depan saya 

dengan menjadi seorang penyelenggaran kesenian atau seniman. 

 SS  S  KS  TS  STS  
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34. Saya merasa pagelaran seni yang saya ikuti sulit melatih kesetiaan dan 

kekompakan dalam bekerja sama. 

 SS  S  KS  TS  STS  

 

35. Saya merasa pagelaran seni yang saya ikuti akan membuat saya dapat 

bertahan hidup dengan menjadi seorang penyelenggaran kesenian atau 

seniman. 

 SS  S  KS  TS  STS  

 

36. Saya merasa pagelaran seni yang saya ikuti hanya melatih kita mengatasi 

situasi yang mudah-mudah saja. 

 SS  S  KS   TS  STS  

 

37. Saya merasa pagelaran seni yang saya ikuti akan memberikan inovasi 

dalam membuka peluang usaha. 

 SS  S  KS  TS  STS  

 

38. Saya merasa pagelaran seni yang saya ikuti akan membuat saya lebih 

produktif dengan menjadi seorang penyelenggaran kesenian atau seniman. 

 SS  S  KS  TS  STS  

 

39. Saya merasa pagelaran seni yang saya hanya membuat pekerjaan 

menambah banyak. 

 SS  S  KS  TS  STS  

 

40. Saya merasa pagelaran seni yang saya ikuti kurang meningkatkan 

optimisme akan keberhasilan suatu acara. 

 SS  S  KS  TS  STS  
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41. Saya merasa pagelaran seni yang saya ikuti akan mengeluarkan 

kemampuan terbaik saya dalam melakukan pertunjukan seni. 

 SS  S  KS  TS  STS  

 

42. Saya merasa pagelaran seni yang saya ikuti akan membuat saya menjadi 

seorang yang berkiprah di bidang kesenian. 

 SS  S  KS  TS  STS  

 

43. Saya merasa pagelaran seni yang saya ikuti agak sulit dalam meningkatkan 

kepercayaan diri saya. 

 SS  S  KS  TS  STS  

           
 

 

3.5 Teknik Pengumpulan Data 

Teknik pengumpulan data adalah cara yang digunakan peneliti untuk 

memperoleh data penelitian dengan menggunakan instrumen penelitian. 

Widoyoko (2014, hlm. 33) menyatakan “metode pengumpulan data merupakan 

strategi atau cara yang digunakan oleh peneliti untuk mengumpulkan data yang 

diperlukan dalam penelitiannya”. Berikut teknik pengumpulan data yang dapat 

digunakan menurut pernyataan Widoyoko (2014, hlm. 33) “Untuk memperoleh 

data seperti yang dimaksudkan tersebut, dalam penelitian dapat digunakan 

berbagai macam metode, diantaranya adalah dengan angket, observasi, 

wawancara, tes, dan analisis dokumen”. Untuk memperoleh data dalam penelitian 

ini dengan menggunakan amgket dan lembar observasi. 

3.5.1 Angket 

Di dalam penelitian ini peneliti menggunakan angket untuk memperoleh 

data. Peneliti mengembangkan angket tentang motivasi kewirausahaan seni 

dengan mengacu pada indikator kewirausahaan. Angket digunakan sebanyak dua 

kali, yakni pada saat sebelum implementasi Project Based Learning dan Sesudah 

implementasi Project Based Learning.  
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3.6 Teknik Analisis Data 

Didalam penelitian ini menggunakan manusia sebagai subjek penelitian 

atau disebut dengan partisipan, patisipan dalam penelitian ini adalah siswa XI 

APK  SMK NU Kaplongan. Data yang akan dianalis dalam penelitian ini adalah 

hasil dari penggunaan instrumen penelitian yang telah dipaparkan di atas. Berikut 

teknik yang digunakan dalam penganalisisan data. 

 

3.6.1 Rata-rata, Simpangan Baku, dan Varian 

Untuk perhitungan rata-rata, simpangan baku dan varian dengan 

menggunakan aplikasi Statistical Package for the Social Sciences (SPSS) versi 

18. Tahapan penghitungan yang akan dilakukan dengan langkah-langkah menurut 

Sufren dan Natanael (2013, hlm. 36)sebagai berikut: klik Analyze>Descriptive 

Statistics >Descriptives> Masukan semua variabel ke kotak Variable(s) 

>Options> ceklis Mean-Std. Deviation-Variance>Continue>OK. 

3.6.2 Uji Normalitas 

Uji normalitas salah satu uji prasyarat yang digunakan untuk mengetahui 

apakah data tersebut berdistribusi normal atau baik. Uji normalitas menggunakan 

kolmogorov-smirnov dengan bantuan Statistical Package for the Social Sciences 

(SPSS) versi 18. Tahapan penghitungan yang akan dilakukan dengan langkah-

langkah menurut Sufren dan Natanael (2013, hlm. 130)sebagai berikut: klik 

Analyze>Nonparametric Tests >Legacy Dialogs > 1-Sample K-S > Masukan 

semua variabel ke kotak Test Variable List >OK. Format pengujiannya dengan 

membandingkan nilai probabilitas (p) atau signifikansi (Sig.) dengan derajat 

kebebasan (dk) α = 0,05. Uji kebermaknaannya sebagai berikut. 

3.6.2.1 Jika nilai Sig. atau P-value> 0,05 maka data dinyatakan normal. 

3.6.2.2 Jika nilai Sig. atau P-value< 0,05 maka data dinyatakan tidak normal. 

3.6.3 Uji Homogenitas 

Uji homogenitas digunakan untuk mengetahui apakah suatu data atau 

sampel yang diambil berasal dari varian yang homogen atau tidak. Uji 

homogenitas dilakukan sebagai prasyarat dalam uji anova. Uji homogenitas 
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menggunakan Lavene Statistic dengan bantuan Statistical Package for the Social 

Sciences (SPSS) versi 18. Tahapan penghitungan yang akan dilakukan dengan 

langkah-langkah menurut Sufren dan Natanael (2013, hlm. 143)sebagai berikut: 

klik Analyze>Compare Means>One-Way ANOVA> Masukan variabel ke kotak 

Dependent List > Masukan faktor ke kotak Factor >Options >Homogenity of 

variance test>Continue>OK. Format pengujiannya dengan membandingkan nilai 

probabilitas (p) atau signifikansi (Sig.) dengan derajat kebebasan (dk) α = 0,05. 

Uji kebermaknaannya sebagai berikut. 

3.6.3.1 Jika nilai Sig. atau P-value> 0,05 maka data dinyatakan homogen. 

3.6.3.2 Jika nilai Sig. atau P-value< 0,05 maka data dinyatakan tidak homogen. 

3.6.4 Uji Hipotesis 

Uji hipotesis yang digunakan dalam penelitian ini menggunakan One-

Sample T Test dan Paired-Samples T Tsetdengan bantuan Statistical Package for 

the Social Sciences (SPSS) versi 18. Tahapan penghitungan yang akan dilakukan 

dalam menghitung One-Sample T Test dengan langkah-langkah sebagai berikut: 

klik Analyze>Compare Means>One-Sample T Tset> Masukan datake kotak Test 

Variable(s), masukan jumlah sampel data ke Test Value>klik OK. Uji 

kebermaknaannya sebagai berikut. 

3.6.4.1 Jika nilai Sig. atau P-value< 0,05 maka data dinyatakan signifikan. 

3.6.4.2 Jika nilai Sig. atau P-value> 0,05 maka data dinyatakan tidak signifikan. 

Kemudan tahapan penghitungan yang akan dilakukan dalam menghitung 

Paired-Samples T Test dengan langkah-langkah menurut Sufren dan Natanael 

(2013, hlm. 133)sebagai berikut: klik Analyze>Compare Means>Paired-Samples 

T Tset> Masukan dataPretest ke kotak Variable1 dan Posttest ke kotak Variable2 

>klik OK. Uji kebermaknaannya sebagai berikut. 

1) Jika nilai Sig. atau P-value< 0,05 maka data dinyatakan signifikan. 

2) Jika nilai Sig. atau P-value> 0,05 maka data dinyatakan tidak signifikan. 

 

3.7 Prosedur Penelitian 

Prosedur penelitian yang akan dipaparkan disini adalah bagaiman langkah-

langkah yang digunakan dalam penyususnan penelitian yang akan dilakukan. 
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Langkah-langkah yang akan ditempuh dalam penelitian ini dengan cara-cara 

sebagai berikut. 

3.7.1 Pembuatan rancangan penelitian langkah-langkah dalam tahap ini yaitu 

menyusun proposal penelitian, akan dijelaskan pada gambar di bawah ini: 

3.7.1.1 Persiapan 

1) Pembuatan proposal 

2) Akses ke subjek penelitian 

3) Perizinan 

4) Rpp 

3.7.1.2 Pelaksanaan 

1) Penyebaran angket sebelum implementasi Project Based Learning 

dilaksanakan pada hari Jumat tanggal 6 April 2018 

2) Implementasi Project Based Learning  

Treatment dalam implementasi Project Based Learning ini dilaksanakan 

sebanyak 9 kali pertemuan. Hal ini dilaksanakan sesuai dengan kebutuhan 

penelitian. Dikarenakan kelas XI pada bulan Januari sampai bulan Maret siswa 

kelas XI sedang melaksanakan praktek kerja lapangan maka penelitian 

dilaksanakan pada bulan April. 

Tabel 3.7. 

Jadwal Pertemuan Treatment Penelitian 

Pertemuan 1 2 3 4 5 6 7 8 9 

Tanggal 

9 

April 

2018 

12 

April 

2018 

16 

April 

2018 

19 

April 

2018 

23 

April 

2018 

26 

April  

2018 

30 

April 

2018 

7 

Mei 

2018 

10 

Mei  

2018 

 

1) Penyebaran angket setelah implementasi Project Based Learning 

dilaksanakan pada hari Jumat tanggal 11 Mei 2018. 

2) Penulisan Laporan Penelitian 

• Analisis data 

• Interpretasi 


